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Abstract
Quantitative cross-linking/mass spectrometry \(QCLMS) probes protein conformational dynamics in
solution. It compares different conformers by quantifying cross-linked peptides obtained by digesting the
proteins after them having been cross-linked in solution in their native fold, conserving structural details
that may be inaccessible by alternative technologies. Computational solutions that automate
quantitation of cross-linking data would promote applications to a wider range of users, beyond the
technical development �eld. Here we present a strategy for quantifying cross-linking data using a well-
established quantitation proteomics software, Skyline. Our approach can be applied to label-free
quantitation, SILAC based quantitation and quantitation using isotope labelled cross-linkers. The
work�ow can be adapted to extend across a wide range of existing computational pipeline, from
identi�cation to quantitation of cross-linked peptides.

Introduction
Quantitative cross-linking/mass spectrometry \(QCLMS) is a relatively young technique for studying
structural dynamics of proteins and protein complexes. It is developed on the base of cross-linking/mass
spectrometry \(CLMS). In CLMS, spatial proximities between amino acid residues in protein chains are
converted into covalent linkages via cross-linkers, whereby the length of cross-links are rede�ned as
distance constraints between cross-linked residue pairs. These linkages are detected by mass
spectrometry in the form of cross-linked peptide pairs \(referred to as cross-linked peptides) and identi�ed
through database search. Data produced by CLMS provide information on protein folding, topologies of
protein complexes and protein-protein interactions1–3. In QCLMS, cross-links obtained at different
conformational states of a protein or a protein complex are compared in a quantitative manner based on
their MS signals. In general, structural rearrangements are expected to be re�ected as yield changes of
cross-links, and locations of cross-links with major changes highlight the structural regions that are
changing. In parallel with standard quantitative proteomics, there are two major strategies for quantifying
cross-links: isotope-labelling and label–free approaches. Thus far, isotope labelled quantitation has only
been applied to compare two structural states of a protein/protein complex. For quantitation purposes,
one of the two protein samples is labelled using heavy isotopes \(for example 2H, 13C, 15N and 18O), and
a 1:1 mixture of the two protein samples is analysed by mass spectrometry. For each cross-linked
peptide, the signals derived from the two protein samples are distinguished by their mass and compared
based on their signal intensities. For example Huang _et al._4 applied 18O-labelling mass spectrometry for
quantitation of cross-links. In this study, following cross-linking, one of two protein conformers was
digested by trypsin in normal water, while the other was digested in H2

18O. Each cross-linked peptide

digested in H2
18O was 8 Da heavier than the same peptide derived from the sample digested in normal

water. Chavez _et al._ applied stable isotope labelling by amino acids in cell culture \(SILAC) in their study
on a protein interaction network, to quantify changes on both yields of cross-links and abundance of
proteins5. An alternative strategy is to use isotope-labelled cross-linkers6. Two different conformational
states of a protein/protein complex are cross-linked separately using the non-labelled and the heavy
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isotope-labelled analogues of a cross-linker. This cross-linking speci�c strategy has been applied in most
reported QCLMS studies7–15, including the �rst protocol for QCLMS16. Compared to a global peptide-
labelling scheme, applying isotope-labelled cross-linkers only labels cross-linker-containing peptides,
minimizing the increase in sample complexity. However, this approach requires pre-separation of different
stable protein/protein complex conformers prior to cross-linking. Furthermore, its application is also
limited by the cross-linking chemistry used, to cross-linkers available in isotope-labelled forms. In
contrast, label-free quantitation tolerates any cross-linking chemistry. In label-free quantitation work�ows,
protein samples of different structural status are not mixed at any step. They are cross-linked, digested
and analysed by LC-MS/MS as separate samples but following identical procedures. For a given peptide
of interest, abundance across the set of samples is compared based on the signal intensities across
individual MS acquisitions. Therefore, label-free quantitation can compare more than two protein
samples in one analysis. Moreover, label-free quantitation does not necessarily require pre-separation of
conformers before cross-linking, as long as they can be resolved after cross-linking, for example as two
separate bands on SDS-PAGE. Hence it has been successfully applied to reveal, in solution, the dynamic
equilibrium of an open and a closed conformations of the complement factor H17. Currently, the vast
majority of reported QCLMS work�ows use MS data acquired in data dependent acquisition \(DDA)
mode, with quantitation carried out using the extracted ion chromatographic intensities of full scan \
(MS1) signals. Although quantifying cross-linked peptides using targeted manner has also been
reported18,19, it is beyond of scope of this protocol. So far, applications of QCLMS have been restricted to
those pioneering labs that have been developing QCLMS. A major reason preventing QCLMS from �nding
wider application is that the only published protocol is based on manual quantitation16. Manual
quantitation of mass spectrometric data requires user expertise and often involves subjective criteria
which are hard to transfer accurately between users and between groups. Furthermore, manual
quantitation is time consuming, and becomes unmanageable when dealing with complex and large
datasets. Great efforts have been put to automate the data processing. So far the reported solutions have
focused in two directions: one is to develop customized software tools for quantifying cross-linking data
such as XiQ20 and xTrac21, the other is to exploit established quantitative proteomics software tools that
routinely do not accommodate cross-linking data, for example vendor software Pinpoint and open
software MaxQuant15 and Skyline22. Applying these solutions to automate data processing offers
opportunities for a transferable QCLMS protocol, allowing for more general application of QCLMS. Here
we describe a generic solution for automatedly quantifying cross-linked peptides using software Skyline,
which is compatible with quantitation work�ows using isotope-labelled cross-linkers, SILAC and label-free
approach. We use the cross-linker BS3 as an example for demonstration as it is one of the most
commonly used cross-linkers for CLMS analysis and is applicable for all three work�ows list above.
**Development of the protocol** In the past decade, numerous software have become available for
identifying cross-linked peptides \(such as xQuest23, MassMatrix24, pLink25, StavroX26, Kojak27, Protein
Prospector28,XlinkX29, and MeroX30. Although a good number of analysis pipelines have been
established and optimized using these different software, in almost all cases, MS data were acquired in
data dependent acquisition mode and high resolution MS1 data was acquired for accurate identi�cation
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of cross-linked peptides. Therefore, a generic quantitation solution would be possible and would allow for
easy extension of many existing work�ows. In QCLMS analysis, structural interpretation of the data is
based on the quantitation of individual cross-links \(cross-linked residue pairs). The mass spectrometric
data is on cross-linked peptides, where ideally multiple support one cross-linked residue pair. This is due
to the existence of modi�cations or missed proteolytic cleavage sites. Nevertheless, it is important to
accurately quantify each cross-linked peptide and be able to view and validate the quantitation easily. We
have explored a few solutions for automated quantitation of cross-linking data. XiQ20 and MaxQuant \
(version 1.5.4.1 and higher)15 quantify cross-linking data in similar ways. They accept lists of MS2
features of cross-linked peptides \(including identi�ed m/z, charge and retention time/scan number of
the identi�ed MS2 events) as input, giving an easy way to feed-in cross-linking data. However, both
software packages have two major limits. First, isotope-labelling based quantitation requires cross-links
to be quanti�ed in replicates with label-swapping and in label free quantitation, the signals of cross-linked
peptides need to be compared across the set of samples. The current version of both XiQ and MaxQuant
do not support transferring identi�cations of cross-linked peptides between MS runs, which means only
cross-linked peptides that are identi�ed in all samples will be quanti�ed. This fact largely limits the
coverage of quanti�ed data. Second, both software packages do not provide an interface for visualizing
the quantitation results. Skyline outshines by overcoming both limits. Skyline is able to project
identi�cations of cross-linked peptides between MS runs by aligning the detected features, which means
as long as a cross-linked peptide is identi�ed in one of samples, its signal will be quanti�ed across the
whole set of samples. Furthermore, Skyline provides nice interfaces for easy and fast visualizing,
validating and correcting quantitation results of individual cross-linked peptides. Last but not least,
Skyline is freely available. As one of the most commonly used quantitative proteomics software tool,
Skyline is under continuous development and support. Detailed user tutorials were offered by Skyline
developers, which can be easily followed by users with little experience. Skyline requires the sequences of
peptides as part of the input for calculating the mass of the peptides, however it does not routinely
accommodate cross-linked peptides. Similar to an approach we previously employed to identify cross-
linked peptides, we established a strategy to convert the sequence of cross-linked peptides into a non-
cross-linked linear form that has identical mass and retains information on cross-linking sites. This
strategy is a general solution for software tools that require peptide sequences for mass calculation but
do not accept sequences of cross-linked peptides. Using linearized sequences for cross-linking data, one
can construct an input text �le using standard Skyline format. Therefore, most existing computational
setups for identi�cation of cross-linked peptide can be adopted to our quantitation work�ow with a single
reformatting step for the identi�cation list of cross-linked peptides. **Limitations of the protocol** When
quantifying cross-linking data using Skyline, we manually inspect the peptide signal selection and correct
the peak isolation window, which improve the accuracy of quantitation results. Although the process time
has been largely reduced compared to quantifying cross-linking data manually \(in average 15 second
per cross-linked peptide versus approximately 5 minutes), this procedure can still become a limiting
factor when working with datasets containing thousands of cross-linked peptides. **Experiment design**
To introduce cross-linking data into the full-scan �ltering pipeline of Skyline, we devised a strategy to
linearize the sequence of cross-linked peptides **Fig. 1a**. The key element in this strategy is to keep the
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mass of the linearized the sequence identical to the mass of the cross-linked peptide \(**Fig. 1b**). This
strategy can be applied to any cross-linker. The example in **Fig.1c** shows one way of doing this. Using
linearized sequences, cross-linked peptides are added to a tab-delimited text �le referred to as ssl \
(spectrum sequence list). The .ssl �le includes the sequence of peptides, the MS �le name, scan number
of the matched MS2 spectrum, and the charge state of the identi�ed cross-linked peptide. This
information allows Skyline to build a library of identi�ed cross-linked peptides and track down their
signals in the mass spectra. The sequence and the identi�ed charge state\(s) are used to calculate the
"m/z" value\(s) of the cross-linked peptide, and the scan number of the matched MS2 spectrum de�nes
the retention time. A “m/z” value in combination with a retention time serves as a coordinate for Skyline
to identify the signal of a cross-linked peptide at a given charge state \(often referred to as a “feature”).
The signal intensity of a feature is measured as the area of its chromatographic peak. The signal
intensity of a cross-linked peptide pair is the sum of signal intensities of all its detected features. In our
approach, isotope labelling through cross-linkers is encoded in structural modi�cations. Therefore, the
identi�cations of both the light and the heavy versions of each cross-linked peptide feature should be
included in the input library. If either version of the cross-linked peptide feature is not identi�ed, a pseudo
identi�cation entry is created by transferring the acquisition �le name and identi�ed MS/MS from the
identi�ed counterpart \(**Fig. 2**). In Skyline, one de�nes global isotopic labelling including SILAC
through "isotope modi�cations". For SILAC based quantitation, only the heavy labelled version of each
cross-linked peptides need to be present in the input �le \(**Fig. 3**) and Skyline would generate
quantitation transitions for both the light and the heavy version of cross-linked peptides in the spectra
library. To maximize the accuracy of quantitation, manual inspection is carried out to ensure that the
correct MS1 signals are isolated \(**Fig. 4**). In addition, few Skyline inbuilt measurements of isolated
MS1 signals have been used as quality control for quantitation results. Isotope dot product compares
isotope distribution of measured MS1 signal against the theoretical distribution calculated based on the
peptide sequences. Low isotope dot product value is considered as an indication of incorrect signal
isolation. At least three isotope peaks of each cross-linked peptides should be used for quantitation to
provide accurate isotope dot product calculations. In label-free quantitation, the coe�cient of variation \
(CV%) is used to measure the reproducibility of peptide signals between replicates. False signal isolation
may lead to high CV%. In isotope labelling based quantitation the light and the heavy versions of each
cross-linked peptides are expected to coelute, although a small shift is allowed when deuterium is applied
for labelling. The quantitation results from Skyline can be exported as .csv �le. One can customize
information that need to be included in the result report. For SILAC based quantitation, the signal ratio of
the light and the heavy version of each cross-linked peptides is calculated in Skyline and can be included
in the report. For label-free quantitation and quantitation using isotope labelled cross-linkers, signal
changes between samples \(_i.e._ conformers) need to be calculated post exporting the data. This
process can be conducted using any spreadsheet applications such as Microsoft Excel.

Equipment
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_Pre-required data_ ==*== Raw mass spectra data �les. ==*== List of peptide-spectra matches \(PSM) for
cross-linked peptides, including raw �le name, scan number, identi�ed charge, and sequence of identi�ed
cross-linked peptides \(including modi�cations). _Software_ ==*== MSconvert \
(http://proteowizard.sourceforge.net) ==*== Skyline \
(https://skyline.ms/project/home/software/Skyline/begin.view) ==*== Spreadsheet applications e.g.,
Microsoft Excel \(version 1997 and higher) _PC hardware_ Computer workstation with dual core
processor, 64-bit Microsoft Windows system \(XP or newer versions), 4GB RAM would meet minimal
requirement for installation of all software listed above.

Procedure
1. Convert vendor speci�c mass spectrometry raw data into the mzML format using MSConvert31. i. Open
software tool msConvert. ii. Select the �le\(s) to be converted. iii. Select the output directory; if not specify,
output �le would by default be placed in the same directory as the input �les. iv. Choose "mgf" as “Output
format”. v. Only if the MS2 spectra are acquired in pro�le mode, select "peakPicking" as a �lter. Otherwise,
leave the “�lter” option empty. vi. Start the process by click on the "start" button. **CRITICAL STEP** A
detailed tutorial for such process can be found at \
(http://proteowizard.sourceforge.net/IntroductoryTutorial.shtml) _Generating Skyline input. ssl �les_ 2.
Linearize the sequences of identi�ed cross-linked peptides as demonstrated in **Fig. 2**. This process
can be automated using a combination of in-built functions in Microsoft Excel. 3. Generate .ssl �les A.
Label-free quantitation Convert modi�cations in the linearized sequences of cross-linked peptides into
Skyline format \(**Fig. 1**). A list of identi�ed features of cross-linked peptides in the standard .ssl
format \(https://skyline.ms/wiki/home/software/BiblioSpec/page.view?
name=BiblioSpec%20input%20and%20output%20�le%20formats) can be generated using Microsoft
Excel. Save this list as a text \(tag delimited) �le, and rename the ==\**==.txt �le as ==\**==.ssl in �le
explorer. B. SILAC based quantitation Generate .ssl �les as described in 3A. In the .ssl �les, if a feature is
identi�ed as the non-isotope-labelled version of a cross-linked peptides, replace the sequence with the
corresponding heavy \(isotope-labelled) version. C. Quantitation using isotope-labelled cross-linkers.
Generate a .ssl �le containing all identi�ed feature of cross-linked peptides as described in 3A. Generate a
separate .ssl �le containing pseudo identi�cation information of cross-linked peptide features.
**CRITICAL STEP** This procedure requires co-elution of the light and the heavy versions of cross-linked
peptides in the reverse phase chromatography in the LC-MS system. It is the case for BS3 and BS3-d4,
however cross-linkers labelled with more deuterium atoms may lead to shift on elution time compared to
their non-labelled analogues. _Quantitation using Skyline MS1 full scan �ltering_ 4. Start Skyline and
open a new �le 5. Set parameters that are relevant to MS1 full scan �ltering i. De�ne modi�cations \
(**Fig. 5**) ==*== Select modi�cations that are prede�ned in Skyline Settings>Peptide
settings>Modi�cations Select modi�cations from the dropdown list, such as Carboxymethyl \(C) and
Oxidation \(M). **?TROUBLESHOOTING** ==*== De�ne user customized modi�cations Settings>Peptide
settings>Modi�cations>Edit list>Add **Table 1** lists modi�cations de�ned for BS3 cross-linking. ==*==
Set "Max variable mods" according to input data. ==**== For SILAC based quantitation de�ne isotope



Page 7/25

labelling scheme \(**Fig. 6*) Settings>Peptide settings>Isotope modi�cations>Edit list>Add Select
prede�ned isotope modi�cation from the dropdown list or de�ned customized isotope modi�cations. ii.
Peptide �lters Settings>Peptide settings>Filter "Min length", “Max length” and should be set accordingly to
include all identi�ed peptides that need to be quanti�ed in the peptide library. iii. Transition full scan
parameters \(**Fig. 7a**) Settings>Transition settings>Full scan ==*== "Isotope peak included" = Count
==*== "Peaks" = number of isotope peaks used for quantitation. **CRITICAL STEP** At least three isotope
peaks are recommended for use in quantitation. However, this number should be less than the mass
difference between the light and the heavy version of a cross-linked peptide when isotope-labelled cross-
linkers are applied for quantitation. ==*== "Precursor mass analyzer" = analyzer applied for acquiring
MS1 spectra. ==*== "Resolving power" = resolution applied for acquiring MS1 spectra. **CRITICAL
STEP** Precursor mass analyzer and Resolver power should be de�ned based on the mass spectrometer
and acquisition method used. ==*== "Retention time �ltering", select “use only scans within \(X) minutes
of MS/MS IDs”. The default time-window is set to �ve minutes, however it can be customized. iv.
Transition �lter \(**Fig. 7b**) Settings>Transition settings>Filter ==*== "Precursor charge" should include
all identi�ed charge state of cross-linked peptides. ==*== "Ion type" = p \(for precursor) 6. Build a peptide
library \(**Fig. 8**) Settings>Peptide settings>Filter>Build Select the .ssl �les as "input �les". **CRITICAL
STEP** A separate library should be built for pseudo identi�cations of cross-linked peptide features when
use isotope-labelled cross-links for quantitation. **?TROUBLESHOOTING** 7. Select spectra libraries for
quantitation. Settings>Peptide settings>Library>Libraries ==*== Select all spectra libraries that should be
used for quantitation for a given dataset from the list. ==*== Select "Pick peptide matching library" 8. Add
peptides in the libraries into the list for quantitation \(calculating transitions for quantitation). ==*== View
spectra libraries in the spectra library explorer View>spectra libraries ==*== Select "Add all" to add all
peptides in the library to the target list for quantitation. Based on the transition parameters set in Step 5,
transitions are calculated for each cross-linked peptide. For SILAC labelled sample, transitions are
calculated for both non-labelled and SILAC labelled version of every cross-linked peptide. **CRITICAL
STEP** If input data consists of multiple libraries \(for example, a separate library is built for pseudo
identi�cations of cross-linked peptide features when use isotope-labelled cross-linkers), after adding
peptides from one library, switch view to another library using the dropdown menu and add peptides.
Repeat the process until peptides in all libraries are added. **?TROUBLESHOOTING** 9. Import mass
spectrometry raw data for quantitation. File>import>results Upload data in .mzML format. **CRITICAL
STEP** For label-free quantitation, MS data of all conformers \(including replicates) should be uploaded
and quanti�ed together. Similarly, when quantifying using isotope-labelled cross-linkers or SILAC, MS
data from the forward-labelled and the reverse-labelled experiments should be uploaded and quanti�ed
together. 10. Quality control of automated quantitation results. **CRITICAL STEP** Like any other
software, errors do exist in the automated quantitation results from Skyline which are mainly resulted
from incorrectly isolated MS1 signals. This happens particularly more often to those low intensity
signals. Skyline provides very user friendly interface for manually inspecting, and correcting the isolate
peptide signals for quantitation. This process can dramatically improve the accuracy of quantitation
results. A. In a typical example, it takes less than 20 seconds to correct isolation windows of a cross-
linked peptides quanti�ed across six samples \(two conformational states, each with triplicated MS
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analysis). Therefore, it is feasible to carry out manual inspection for every cross-linked peptide when
quantifying dataset of few hundred cross-linked peptides. i. View>Arrange Graphics>Tiled Display
chromatogram of all quanti�ed samples in a tiled view \(each MS acquisition in a separate window). ii.
Click on one cross-linked peptide listed in the "targets" list to display the extracted MS1 signals of this
peptide in each MS acquisition. iii. Right click on one chromatogram, under "peptide ID times" option
select “matching” and “aligned” to display retention time of identi�ed MS2 events and/or aligned
identi�cation of this peptide in each MS acquisition. iv. View>Peak areas>Replicate comparison. The
abundance of isolated MS1 signals of the selected peptide in each MS acquisition are shown in a bar
chart with isotope dot products labelled \(in a new window). The isotope dot product compares the
intensities of isolated isotope peak signals against the theoretical isotope abundance distribution
calculated based on peptide sequence. A dot product value can range between 0 and 1, and 1 indicates a
perfect match. v. Inspect the isolated peptide signal according to following criteria: ==*== Isolation
window includes the whole elution peak. ==*== Isolated elution window agrees with the retention time \
(RT) of identi�ed MS2 events or aligned identi�cation RT. ==*== Isotope dot product value is 0.9 or higher
==*== If Isotope dot product value is lower than 0.9, exam the MS1 spectrum of the selected peptide by
clicking on the elution peak in the chromatogram \(a new window will appear with MS1 spectrum). vi.
Correct the isolation window if not correct. vii. Move to the next cross-linked peptides until going through
all peptides in the "target" list. B. When working with larger datasets, it becomes unfeasible time-wise to
manually inspect quantitation results of each individual cross-linked peptide. In such cases, one could
utilize Skyline’s inbuilt measurements for isolating peptide signals to �lter out cross-linked peptide that
are likely to be incorrectly quanti�ed and carry out manual inspection and correction only on this subset
of data. i. Export the automated quantitation result following Step 11 and 12 with two additional data
columns: ==*== Isotope Dot Product \(Proteins>Peptides>Precursors>Precursor Results) ==*== Peptide
Retention Time \(Proteins>Peptides>Peptide results) ii. View the automated quantitation results in
Microsoft Excel \(version 1997 and higher). iii. Any isolated MS1 signal of a cross-linked peptide with
isotope dot product value below 0.9 should be manually inspected. iv. For label-free quantitation,
calculate the coe�cient of variation \(CV) value on "Normalized Area" for the triplicate of each sample as
standard deviation divided by mean. Cross-linked peptides with CV% higher than 20% within a sample
should be manually inspected v. For SILAC based quantitation, calculate the retention time difference
between the light and the heavy signals of a cross-linked peptide. If it is larger than 20 seconds, manually
inspect the isolated signal of this cross-linked peptides vi. For quantitation using isotope-labelled cross-
linkers when the retention time difference between the light and the heavy signals of a cross-linked
peptide is larger than 40 seconds, manually inspect the isolated peptide signal vii. Follow the procedures
list in Step 10A, manually inspect the isolate MS1 signals of cross-linked peptides if it ful�ls any
conditions listed above \(iii-vi) viii. Export manually corrected quantitation results following Step 11 and
12. 11. Customize contents \(data columns) in the quantitation results report View>Document
Grid>Views>Edit view Following data columns should be included in the results report. ==*== Peptide
Modi�ed Sequence \(Proteins>Peptides) ==*== Replicate Name \(Replicates) ==*== Normalized Area \
(Proteins>Peptides>Peptide results>Quantitation) ==*== Isotope Label Type \(Proteins>Peptides>Peptide
results) \(only for SILAC based quantitation) ==*== RatioLightToHeavy \(Proteins>Peptides>Peptide
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results) \(only for SILAC based quantitation) 12. Export report for automated quantitation results
File>Export>Report The reports are in .csv format.

Timing
Step 1, Converting MS data to mzML format \(1-5 minutes, per raw MS �le). Step 2-3, Linearize the
sequence of cross-linked peptides and generate .ssl �le \( ==~== 1 hour with excel). Step 4-5, Setting up
Skyline parameters. \(5-10 minutes) Step 6, Build peptide library \(30 minutes – few hours depending on
the size of the .ssl �les and the number of mzML �les) Step 7-8, Generating list of cross-linking with
calculated transitions for quantitation \(30 minutes -few hours, depends on number of cross-linked
peptides. Step 9, Import MS raw data for quantitation \( ==~== 10 minutes per raw �le with 180 minutes
acquisition time). Step 10, Manual inspection and correction of quantitation results. \(In average 15
second per cross-linked peptide). Step 11-12, Export Skyline quantitation results. \( ==~== 30 minutes)

Troubleshooting
Troubleshooting advice can be found in Table. 2
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Figure 1

Linearization of cross-linked peptide sequences (*a*) A scheme for converting the sequence of a cross-
linked peptide to a linear sequence with identical mass. (*b*) The scheme of mass calculation for the
linearization of cross-linked peptide sequences. (*c*) An example for converting the sequence of a BS^3^
cross-linked peptide into the linear sequence for work in Skyline, applying the settings shown in (*b*).
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Figure 2

Schematic demonstration on how to generate pseudo identi�cation entries in the .ssl �le (*a*) The
extracted ion chromatogram (XIC) of the BS^3^- (light) and the BS^3^-d4- (heavy) version of a cross-
linked peptide (the MS1 spectrum is shown below). The overlapped elution window of the light and the
heavy versions of the cross-linked peptide allowed for applying the retention time of the identi�ed MS2
event of the light version as the retention time of the pseudo identi�cation event for the heavy version
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which not been actually identi�ed. (*b*) An example on how to generate a pseudo identi�cation entry of a
BS^3^-d4 cross-linked peptide in an .ssl �le, based on the MS2 information of the identi�ed BS^3^ cross-
linked version of this cross-linked peptide.

Figure 3

Schematic demonstration on how to de�ne isotopic modi�cations in peptide sequence and generate
SILAC labelled version of cross-linked peptide identi�cation as entries in an .ssl �le
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Figure 4

Common errors on peptide signal isolation in Skyline (*a*) An example of a correctly isolated
chromatographic signal of a peptide. The elution peak is correctly isolated; the isotope distribution of the
isolated signals is in good agreement (with the "idotp" close to 1) with the expected pattern calculated
based on the sequence of the target peptide; the measured signals of isotope peaks are in good matches
with the calculated m/z of isotope peaks of the target peptide. (*b*) One error on peptide signal picking is
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incorrectly isolated elution peak of the target peptide. (*c*) Skyline might pick wrong signals for a target
peptide, the error can be indicated by poor agreement on isotope distribution between the expected and
the measured pattern, showing as low “idotp”. (*d*) The mistakenly selected signal may share the same
charge as the target peptide which might resulted in an “idotp” value close to one. Such signal picking
error would only be revealed when compare isotope peaks of the isolated signal in the MS1 spectra with
the m/z of expected isotope peaks of the target peptide.

Figure 5

Demonstration on how to de�ne modi�cations in Skyline
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Figure 6

Demonstration on how to de�ne isotopic modi�cations in Skyline
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Figure 7

Transition settings that need to be de�ned when quantifying (*a*) For "Full Scan" settings and (*b*) for
transition �lter
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Figure 8

Demonstration on how to build a library in Skyline
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Figure 9

Figure 1 Linearization of cross-linked peptide sequences (a) A scheme for converting the sequence of a
cross-linked peptide to a linear sequence with identical mass. (b) The scheme of mass calculation for the
linearization of cross-linked peptide sequences. (c) An example for converting the sequence of a BS3
cross-linked peptide into the linear sequence for work in Skyline, applying the settings shown in (b).
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Figure 10

Figure 2 Schematic demonstration on how to generate pseudo identi�cation entries in the .ssl �le (a) The
extracted ion chromatogram (XIC) of the BS3- (light) and the BS3-d4- (heavy) version of a cross-linked
peptide (the MS1 spectrum is shown below). The overlapped elution window of the light and the heavy
versions of the cross-linked peptide allowed for applying the retention time of the identi�ed MS2 event of
the light version as the retention time of the pseudo identi�cation event for the heavy version which not
been actually identi�ed. (b) An example on how to generate a pseudo identi�cation entry of a BS3-d4
cross-linked peptide in an .ssl �le, based on the MS2 information of the identi�ed BS3 cross-linked
version of this cross-linked peptide.
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Figure 11

Figure 3 Schematic demonstration on how to de�ne isotopic modi�cations in peptide sequence and
generate SILAC labelled version of cross-linked peptide identi�cation as entries in an .ssl �le
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Figure 12

Figure 4 Common errors on peptide signal isolation in Skyline (a) An example of a correctly isolated
chromatographic signal of a peptide. The elution peak is correctly isolated; the isotope distribution of the
isolated signals is in good agreement (with the “idotp” close to 1) with the expected pattern calculated
based on the sequence of the target peptide; the measured signals of isotope peaks are in good matches
with the calculated m/z of isotope peaks of the target peptide. (b) One error on peptide signal picking is
incorrectly isolated elution peak of the target peptide. (c) Skyline might pick wrong signals for a target
peptide, the error can be indicated by poor agreement on isotope distribution between the expected and
the measured pattern, showing as low “idotp”. (d) The mistakenly selected signal may share the same
charge as the target peptide which might resulted in an “idotp” value close to one. Such signal picking
error would only be revealed when compare isotope peaks of the isolated signal in the MS1 spectra with
the m/z of expected isotope peaks of the target peptide.

Figure 13

Figure 5 Demonstration on how to de�ne modi�cations in Skyline
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Figure 14

Figure 6 Demonstration on how to de�ne isotopic modi�cations in Skyline
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Figure 15

Figure 7 Transition settings that need to be de�ned when quantifying (a) For “Full Scan” settings and (b)
for transition �lter
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Figure 16

Figure 8 Demonstration on how to build a library in Skyline
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